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Аннотация.В статье подробно излагается алгоритм сжатия информации
о геометрическом строении трехмерных пространственных моделей и мно-
гомерных триангуляций, основанный на использовании смежности граней.
Этот алгоритм преобразует набор граней 3D-модели в список цепочек (list
of chains), последовательно расположенных в пространстве и смежных меж-
ду собой. Сжатие информации происходит за счет отсутствия дублирования
номеров вершин, образующих грани модели. Описанный в статье алгоритм
состоит из трех основных частей. В первой части по множеству граней моде-
ли строится специальный граф граней – ребра графа соответствуют смежным
граням. Используя алгоритм обхода вершин графа в глубину, этот граф раз-
бивается на простые цепи. Вторая часть алгоритма преобразует каждую цепь
графа в последовательность номеров вершин, участвующих в формировании
граней этой цепочки. Третья часть алгоритма призвана выполнять обратное
действие – переводить построенную последовательность номеров вершин об-
ратно в наборы кортежей, состоящих из номеров вершин, соответствующих
граням 3D-модели. Указанный алгоритм распространен и на случай простран-
ственных триангуляций полигональных областей. Программная реализация
алгоритма для частного случая 3D-моделей выполнена в виде встраиваемых
модулей в программу Blender. Архивы модулей свободно доступны в репози-
тории автора статьи по адресу: https://github.com/KlyachinVA/LocFile.

Ключевые слова: триангуляция, граф модели, цепь граней, обход графа
в глубину, смежность граней.
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Введение

В настоящей статье предлагается алгоритм сжатия геометрических данных для
представления 3D-моделей произвольной топологии. Надо сказать, что тема эта доста-
точно актуальна [9; 10] в связи с нарастающей сложностью 3D-моделей, и соответству-
ющая задача имеет ряд готовых решений. Например, on-line сервис Free online app
for Wavefront OBJ files compression [11] предлагает сжать модели и представить их в
форматах OBJ, 3DS, STL в более компактном виде. Однако простые эксперименты, вы-
полненные автором для сложных моделей неправильной формы, показывают, что при
выполнении операции сжатия OBJ -> OBJ коэффициент сжатия практически равен 1.
Отметим работу [7], в которой предлагается алгоритм сжатия, основанный на идее ис-
пользования в моделях повторяющихся примитивов, а также – присутствия на модели
плоских элементов. Следует также упомянуть работу [8], в которой для сжатия в основу
положен алгоритм квадратичной ошибки (Quadric Error Metrics Algorithm). Интересен
также обзор [12], в котором вкратце описан алгоритм, похожий на представленный в
нашей статье.

Идея алгоритма, представленного в настоящей работе, и краткое его описание бы-
ли даны также в работах [1; 3; 4]. В работе [4] рассмотрен произвольный случай три-
ангуляций полигональных областей многомерного пространства, тогда как в работе [1]
представлен алгоритм исключительно для двумерных полигональных поверхностей, од-
нако не указаны оценки степени сжатия моделей. Более того, в этой работе рассмат-
риваются два вида последовательности граней: веерные и полосные. В нашей статье
описан алгоритм, не использующий структуру последовательности граней, и, в отличие
от указанных выше работ, описан алгоритм разбиения 3D-модели на полосы – в нашей
терминологии цепочки граней. Программная реализация описанного в настоящей статье
алгоритма может быть полезна для представления геометрических объектов в сжатой
форме в различных задачах, таких как, например, в задаче пространственной рекон-
струкции объектов по их изображениям [2] или в задаче расчета формы равновесного
состояния гиперупругого тела [6].

1. Представление 3D-моделей

Геометрическая структура 3D-моделей задается двумя последовательностями (спис-
ками, массивами) векторов. Первый список задает массив вершин модели

𝑃 = {𝑝𝑖 = (𝑥𝑖, 𝑦𝑖, 𝑧𝑖), 𝑖 = 1, ..., 𝑁}.

Второй список 𝐹 составлен как список описания граней 3D-модели. Мы предполагаем,
что грани являются треугольниками. Пусть 𝑀 – число треугольных граней модели и 𝐹𝑗

это 𝑗-я ее грань, 𝑗 = 1, ...,𝑀 . Тогда

𝐹𝑗 = (𝑛1, 𝑛2, 𝑛3)

означает, что 𝐹𝑗 – это пространственный треугольник с вершинами в точках 𝑝𝑛1 , 𝑝𝑛2 , 𝑝𝑛3 .
Такое представление геометрической структуры 3D-моделей используется в формате
OBJ. Описание элементов массива 𝑃 в OBJ-файлах задается отдельными строками,
начинающимися с символов «v» (от слова vertex – вершина), а описание элементов мас-
сива 𝐹 – строками, начинающимися с символов «f» (от слова face – грань). Заметим,
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Рис. 1. Модель куба

Рис. 2. Блок-схема алгоритма построения списков инцидентных граней

что для описания модели с 𝑀 числом граней нам потребуется ровно 3𝑀 целочисленных
номера.

Пример. Для задания куба [0, 1]3 ⊂ R3 (см. рис. 1) используем два массива

𝑃 = {𝑝𝑖 = (𝑥𝑖, 𝑦𝑖, 𝑧𝑖), 𝑥𝑖, 𝑦𝑖, 𝑧𝑖 ∈ {0, 1}, 𝑖 = 1, .., 8},

𝐹 = {(1, 2, 3), (2, 3, 4), (1, 2, 6), (1, 6, 5), (2, 3, 7), (2, 7, 6),

(3, 4, 8), (3, 8, 7), (4, 1, 5), (4, 5, 8), (5, 6, 7), (5, 7, 8)}.

Во многих задачах по обработке 3D-моделей используется построение для каждой
вершины списка ее инцидентных граней. На основе вышеописанного представления
геометрии моделей несложно получить алгоритм такого построения. Он представлен на
диаграмме рисунка 2.

2. Алгоритм сжатия

Как и многие алгоритмы сжатия, в представленном алгоритме используется избы-
точность информации. Заметим, что порядок перечисления граней в массиве 𝐹 не ва-
жен. Но если мы будем использовать связность граней, то вместо 6 номеров {(𝑛1, 𝑛2, 𝑛3),
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Рис. 3. Иллюстрация к алгоритму сжатия

(𝑛2, 𝑛3, 𝑛4)} для двух соседних (смежных) граней нам понадобится всего 4 {𝑛1, 𝑛2, 𝑛3, 𝑛4}
(рис. 3).

Если мы свяжем по такому принципу в последовательную цепочку 𝑚 граней, то,
как не сложно вычислить, вместо 3 ·𝑚 номеров граней мы можем задействовать только
3 + 𝑚 − 1 = 𝑚 + 2 номера. Предположим, что мы сможем все грани разместить в 𝐿
цепочек и 𝑗-я цепочка будет содержать 𝑚𝑗 граней. Тогда для описания каждой цепочки
граней мы задействуем 𝑚𝑗 + 2 целочисленных номера. Суммируя по всем цепочкам,
получим

𝐿∑︁
𝑗=1

𝑚𝑗 + 2 = 𝑀 + 2𝐿.

Таким образом, для описания граней мы задействуем 𝑀 + 2𝐿 номера вместо 3𝑀 . За-
метим, что при указанном способе записи граней получить доступ к отдельной грани
можно только последовательно в каждой цепочке. Поэтому среднее время доступа к от-
дельной грани в 𝑗-й цепочке будет равно 𝑐 ·𝑚𝑗 . Поскольку цепочки образованы также с
помощью контейнера с последовательным доступом, то доступ к началу цепочки можно
получить за среднее время 𝑐 · 𝐿. Если принять, что средняя длина цепочки равна 𝑀/𝐿,
получим, что полное среднее время доступа к отдельной грани равно

𝑇 (𝐿) = 𝑐 · 𝐿+ 𝑐
𝑀

𝐿
.

Минимальное значение этой функции равно

𝑇𝑚𝑖𝑛 = 𝑇 (
√
𝑀) = 2𝑐

√
𝑀.

Таким образом, оптимальное разбиение 3D-модели на цепочки мы получим при количе-
стве цепочек

√
𝑀 по

√
𝑀 граней в каждой цепочке. При этом количество номеров для

задания граней будет равно

𝑀 + 2𝐿 = 𝑀 + 2
√
𝑀 = 𝑀

(︂
1 +

2√
𝑀

)︂
.

Поэтому асимптотически, при 𝑀 → +∞, предлагаемый способ записи граней модели
будет в три раза экономней традиционного.

Замечание 1. Следует отметить, что при загрузке модели в какой-либо 3D-редактор,
например Blender, соответствующая программа использует свое собственное ее пред-
ставление. Загрузка модели в память подразумевает последовательный доступ к граням
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Рис. 4. Полоса граней

модели, независимо от способа их хранения – различается только порядок, в котором
грани будут загружены. С этой точки зрения, задача уменьшения объема дискового
пространства, который занимает файл с 3D-моделью, является более актуальной, чем
задача ускорения доступа к граням модели.

Приступим к более детальному описанию способа записи цепочек. Заметим, что
в работе [1] требуется согласованность ориентаций каждой грани с соседними. Это
необходимо для того, чтобы правильно выделять тройку номеров очередной грани при
просмотре цепочки номеров. При этом выделяют последовательности двух типов: после-
довательность типа «веер» и последовательность типа «полоса». При последовательности
типа «веер» номера из последовательности номеров вершин чередуются в определенном
порядке. Например, если последовательность граней такая, как на рисунке 4, то соответ-
ствующая последовательность номеров 3, 7, 8, 15, 19, 4 легко преобразуется в последова-
тельность троек номеров, описывающих грани: {(3, 7, 8), (7, 8, 15), (8, 15, 19), (15, 19, 4)}.

Если последовательность устроена как веер (см. рис. 5), то также имеется опреде-
ленная закономерность получения троек, определяющих соответствующие грани. Имен-
но, из последовательности номеров 7, 3, 8, 15, 19, 4 находим последовательно тройки:
{(7, 3, 8), (7, 8, 15), (7, 15, 19), (7, 19, 4)}. В соответствии с этими примерами, алгоритм
из работы [1] выявляет последовательности этих двух типов и записывает их указан-
ным выше способом.

Мы предлагаем алгоритм, в котором не разделяем эти два случая и обрабатываем
последовательности граней независимо от их типа. Для иллюстрации идеи рассмотрим
пример последовательности граней на рисунке 6. По последовательности номеров вер-
шин 7, 3, 8, 15, 11, 19, 4, 5, 14, 1 сложно собрать тройки, определяющие соответствующие
грани. Воспользуемся таким правилом. Первую тройку запишем таким образом, чтобы
первый номер соответствовал вершине, противоположной общему ребру следующей гра-
ни. В нашем случае это тройка (7, 3, 8). Затем будем поступать так. Если следующее
общее ребро лежит напротив вершины с номером 3, то в последовательность добавляем
номер следующей вершины – номер 15. Поступая таким образом, получим последова-
тельность 7, 3, 8, 15, 11, 19, 4. Это дает способ построения троек номеров вершин граней,
как и для последовательностей типа полосы: {(7, 3, 8), (3, 8, 15), (8, 15, 11), (15, 11, 19),
(11, 19, 4)}. А вот при добавлении вершины с номером 5 заметим, что, действуя по
такой же схеме, мы получим тройку (19, 4, 5), которая не определяет никакой грани
модели. Вместо этой тройки нужно использовать тройку (11, 4, 5). Другими словами, в
этой ситуации мы тройку собираем из нового номера из последовательности, последнего
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Рис. 5. Веер граней

номера последовательности и недостающего номера из предыдущей тройки. Чтобы по-
следовательность управляла таким алгоритмом, мы эту ситуацию в последовательности
будем отмечать отрицательными значениями – количество номеров от этого не изме-
нится. Таким образом, мы получим два алгоритма – один строит последовательность
номеров по связной цепочке граней, а другой, наоборот, – строит цепочку граней по
последовательности.

Опишем алгоритм преобразования цепочки граней в последовательность номеров
вершин в общих обозначениях.

• Инициализация.

Извлекаем две тройки номеров вершин первой и второй грани цепочки. Для трой-
ки первой грани находим номер вершины 𝑛0, которая не является инцидентной
второй грани. Помещаем первую тройку в формируемую последовательность но-
меров в порядке – сначала 𝑛0, а потом остальные две.

• Общий шаг цикла.

Пусть 𝑛0, 𝑛1, ..., 𝑛𝑘 – текущая сформированная последовательность номеров вер-
шин цепочки граней, 𝑇 = (𝑚1,𝑚2,𝑚3) – тройка, соответствующая предыдущему
шагу алгоритма, а 𝑇 ′ = (𝑘1, 𝑘2, 𝑘3) – вновь рассматриваемая тройка следующей
грани. Предположим, что

𝑘3 = 𝑇 ′ ∖ (𝑇 ′ ∩ 𝑇 )

есть номер вновь добавляемой вершины. Если равны множества

{𝑛𝑘, 𝑛𝑘−1, 𝑘3} = {𝑘1, 𝑘2, 𝑘3},

то в последовательность добавляем 𝑘3. Если же равны такие множества

{𝑛𝑘, 𝑛𝑘−2, 𝑘3} = {𝑘1, 𝑘2, 𝑘3},

то в последовательность добавляем −𝑘3.

Теперь рассмотрим алгоритм, который последовательность номеров будет преобра-
зовывать в последовательность троек смежных граней.

20 В.А. Клячин. Цепной алгоритм сжатия 3D-моделей
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Рис. 6. Иллюстрация к алгоритму записи цепочек граней

Рис. 7. Пример графа граней модели куба

• Инициализация.

Создается пустой список и в него добавляется кортеж (𝑛0, 𝑛1, 𝑛2) из трех первых
элементов последовательности.

• Общий шаг цикла.

Пусть на предыдущем шаге сконструирован кортеж (𝑚1,𝑚2,𝑚3). Извлекаем сле-
дующий элемент последовательности 𝑛𝑘. Если 𝑛𝑘 > 0, то в список добавляется
кортеж (𝑚2,𝑚3, 𝑛𝑘). Если 𝑛𝑘 < 0, то в список добавляется кортеж (𝑚1,𝑚3,−𝑛𝑘).

3. Алгоритм конструирования цепочек на основе графа граней

Для построения списка цепочек граней нам понадобится предварительно сконстру-
ировать вспомогательный граф граней.

Пусть пара (𝑃, 𝐹 ) задает геометрическую структуру 3D-модели 𝑆 с 𝑁 вершинами
и 𝑀 треугольными гранями. Построим граф 𝐺(𝑆) граней модели 𝑆, полагая в качестве
множества 𝑉 его вершин множество 𝐹 граней модели 𝑆. Две грани 𝑓, 𝑔 ∈ 𝐹 образуют
ребро 𝑒 = (𝑓, 𝑔) ∈ 𝐸 графа 𝐺(𝑆), если эти грани смежны в модели 𝑆. На рисунке 7
изображен пример такого графа для модели куба с рисунка 1.

Для получения списка цепочек граней необходимо представить граф 𝐺(𝑆) в виде
набора простых цепей. Чтобы это сделать, воспользуемся алгоритмом обхода вершин
графа в глубину. Предварительно для каждой вершины 𝑣 графа вычислим список 𝑁 [𝑣]
номеров вершин, смежных с вершиной 𝑣.

ISSN 2587-6325. Математ. физика и компьютер. моделирование. 2025. T. 28. № 2 21



МОДЕЛИРОВАНИЕ, ИНФОРМАТИКА И УПРАВЛЕНИЕ

• Инициализация.

Создаем пустой список 𝐶 цепей, создаем пустой список 𝑊 пройденных вершин
графа, создаем пустой список 𝑈 номеров вершин для текущей цепи и создаем
пустой стек 𝑄. Выбираем первую вершину 𝑣 графа и помещаем ее в стек.

• Общий шаг цикла.

1) Если стек 𝑄 пуст – завершить цикл.
2) Извлекаем из вершины стека номер очередной вершины 𝑣 = 𝑄.𝑝𝑜𝑝().
3) Проверяем, если 𝑣 ∈ 𝑊 , то переходим к следующей итерации цикла.
4) Проверяем, если список 𝑈 не пуст и для вершины 𝑢, последней добавленной

в 𝑈 , выполнено
𝑣 ̸∈ 𝑁 [𝑢],

добавляем цепочку 𝑈 в список 𝐶, создаем новую пустую цепочку 𝑈 и вносим
в нее вершину 𝑣.

5) Если же 𝑣 ∈ 𝑁 [𝑢], то просто добавляем 𝑣 в текущую цепочку 𝑈 .
6) Если оказалось, что цепочка 𝑈 пустая, то добавляем в нее вершину 𝑣.
7) Добавляем вершину в список пройденных вершин 𝑊 .
8) Перебираем все вершины 𝑢 ∈ 𝑁 [𝑣], и если 𝑢 ̸∈ 𝑊 , добавляем ее в стек

𝑄.𝑝𝑢𝑠ℎ(𝑢).

• После завершения цикла.

Завершив цикл, добавим последнюю цепочку 𝑈 в список 𝐶.

4. Многомерный случай

В работах [7; 9; 10; 12] рассматривался случай двумерных граней 3D-моделей. Од-
нако задача сжатия триангуляций может быть полезной и в пространствах большей
размерности. Например, для хранения результатов расчетов равновесных форм дефор-
мированных гиперупругих тел в нелинейной теории упругости [4–6]. Здесь мы приведем
описание алгоритма сжатия произвольных триангуляций в пространстве R𝑛. При этом
мы ограничиваемся случаем, когда объединение всех симплексов триангуляции образует
связное множество – многогранник.

Пусть 𝑃 = {𝑝𝑖, 𝑖 = 1, ..., 𝑁} – вершины триангуляции 𝑇 в пространстве R𝑛, 𝑛 ≥ 1.
Симплексы такой триангуляции задаются списком кортежей вида

(𝑚𝑗
0,𝑚

𝑗
1, ...,𝑚

𝑗
𝑛) 𝑗 = 1, ...,𝑀

номеров вершин симплексов. Граф граней 𝐺 = 𝐺(𝑇 ) триангуляции 𝑇 определяется так-
же, как и выше. В качестве вершин используются грани триангуляции, а каждое ребро
соответствует двум смежным граням. Алгоритм построения этого графа для многомер-
ной триангуляции не сильно отличается от такового для 3D-моделей, и поэтому мы его
не будем приводить. Алгоритм построения цепочек граней сводится к решению задачи на
абстрактном графе и вообще не зависит от происхождения графа. Уточнения требуют
только два алгоритма: алгоритм преобразования цепочки грани в последовательность
номеров и обратный алгоритм преобразования последовательности номеров вершин в
цепочку граней.
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Рис. 8. К общему шагу алгоритма

Ниже представлен алгоритм записи цепочки симплексов в последовательность но-
меров.

• Инициализация.

Через 𝑆 будем обозначать текущий вспомогательный симплекс, а через 𝑆 ′ – оче-
редной обрабатываемый симплекс из цепочки (рис. 8). Инициализируем 𝑆 первым,
а 𝑆 ′ вторым симплексом из цепочки. В последовательность номеров 𝐻 запишем
значения из 𝑆.

• Общий шаг цикла. Вычисляем номера

𝑘1 = 𝑆 ∖ 𝑆 ′, 𝑘2 = 𝑆 ′ ∖ 𝑆.

Поскольку симплексы 𝑆 и 𝑆 ′ всегда смежны (так как они последовательно рас-
положены в одной цепочке), то номера 𝑘1, 𝑘2 однозначно определены. Пусть 𝑘
обозначает индекс номера 𝑘1 в 𝑆.

Заменим в наборе номеров симплекса 𝑆 номер 𝑘1 на 𝑘2 и добавим значение
𝑘 · 𝑁 + 𝑘2 в последовательность 𝐻. После этого извлекаем из цепочки очеред-
ной симплекс 𝑆 ′.

Замечание 2. В описанном выше алгоритме для указания индекса 𝑘 ∈ {0, ..., 𝑛} вер-
шины симплекса, не принадлежащего общей грани смежных симплексов, используется
смещение номера вершины 𝑘2 на величину 𝑘 · 𝑁 . Вместо этого можно было бы запи-
сывать в последовательность 𝐻 само число 𝑘. Это выгоднее с точки зрения экономии
дискового пространства, если результат записывается в текстовый формат. Если же
предполагается последовательности номеров записывать в бинарном виде в файл, то
экономнее будет описанный в алгоритме прием. В обратном алгоритме преобразования
мы покажем, как это смещение используется для восстановления цепочки симплексов.

• Инициализация.

Из последовательности 𝐻 извлекаем первые 𝑛+1 номеров. Они образуют вспомо-
гательный симплекс 𝑆. Создаем пустую цепочку симплексов 𝐶 и добавляем в нее
симплекс 𝑆.

• Общий шаг алгоритма.
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Извлекаем из последовательности очередной номер 𝑙 и вычисляем индекс, полагая

𝑘 =

[︂
𝑙

𝑁

]︂
.

Далее, используя этот индекс, вычисляем номер вершины по формуле

𝑘1 = 𝑙 − 𝑘 ·𝑁.

Формируем новый симплекс 𝑆 ′, заменяя в 𝑆 по индексу 𝑘 номер на 𝑘1. Добавляем
𝑆 ′ в 𝐶 и делаем 𝑆 ′ текущим 𝑆 = 𝑆 ′.

5. Программная реализация

Описанные выше алгоритмы в части 3D-моделей реализованы в виде встраиваемых
модулей в пакет Blender на языке программирования Python. Эти модули в виде zip-
архивов можно свободно скачать из репозитория автора статьи по адресу: https://github.
com/KlyachinVA/LocFile. Чтобы воспользоваться модулями, нужно их установить для
пакета Blender следующим образом. Необходимо в программе Blender выбрать пункт
меню Edit -> Preferences и далее выбрать вкладку Add-ons. На появившейся панели
найти инструмент Install from Disk и, не распаковывая zip-архивы скаченных модулей,
установить их. После этого в меню File -> Export появится пункт Export to loc file.
Чтобы сохранить модель в формат LOC (List Of Chains), необходимо, чтобы модель
была связна, а ее грани были треугольными. Последнее легко добиться с помощью мо-
дификатора Triangulation. Второй модуль loc_file_import.zip реализует загрузку модели
в формате LOC в окно 3D-вида программы Blender. Модуль доступен через меню File
-> Import -> Loc Data Import.
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Abstract. The article describes in detail the algorithm for compressing
information about the geometric structure of three-dimensional spatial models
and multidimensional triangulations based on the use of adjacency of faces. This
algorithm transforms a set of 3D-model faces into a list of chains sequentially
located in space and adjacent to each other. Information compression occurs due
to the absence of duplication of the numbers of vertices that form the model
faces. The algorithm described in the article consists of three main parts. In
the first part, a special graph of faces is constructed based on the set of model
faces, the edges of the graph correspond to adjacent faces. Using the algorithm of
traversal of graph vertices in depth, this graph is divided into simple chains. The
second part of the algorithm transforms each chain of the graph into a sequence
of numbers of vertices participating in the formation of the faces of this chain.
The third part of the algorithm is designed to perform the reverse action – to
translate the constructed sequence of vertex numbers back into sets of tuples
consisting of the numbers of vertices that form the faces of the 3D-model. This
algorithm is also extended to the case of spatial triangulations of polygonal areas.
The software implementation of the algorithm for the special case of 3D-models
is made in the form of built-in modules in the Blender program. The archives of
the modules are freely available in the repository of the author of the article at
https://github.com/KlyachinVA/LocFile.

Key words: triangulation, model graph, face chain, depth-first graph traversal,
face adjacency.
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